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Overview 

The Wedge software was developed to help users upload and download 
database(s) to or from the 60 Series indicators, including the 675 and 672 
indicators. 
 
It can also be used to collect data from an indicator (i.e. Custom transmits) into a 
comma-delimited format (a database format).  A program such as Microsoft 
Excel can then view this data. 
 
The Power of ActiveX lets you view, write data at the same time, which is coming 
from an indicator into an Excel spreadsheet, Access Database. 

 

Installation 

There are 2 components of Wedge to be installed.  First install Wedge Server.  
This is the main Wedge program.    
 
Then install Wedge Active X Client.  The Active X client allows you to 
manipulate data using Microsoft Visual Basic.  This installation is optional. 
 
Follow the prompts to install each piece of the software. 

 

Connecting Wedge to an indicator: 

The Wedge can be connected to the indicator(s) via RS-232, RS485 or Ethernet. 
 
Serial RS-232:  Connect the indicator to the computer through any available 
RS232 port using a standard RS232 cable. 
 
RS-485:  The indicator must be set up for this option.  RS-485 option cards are 
available through GSE Scale Systems. 
 
Ethernet: The computer and the indicator must be set up for this option. The 
Ethernet options can be purchased through GSE Scale Systems. 
 
When using Wedge software, make sure that the indicator has the recommended 
firmware version.  If it does not, it may look like it’s working, but it will not have 
full functionality.  Re-flash software and files can be downloaded from the web 
site: www.gse-inc.com 
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Toolbar: File 

The File Menu is similar to windows.  Within the File menu, the following choices 
are available: 
 
New Program:   -Start a new application 
Open Program:   -Open an existing application 
Save:     -Save the current application  
Save As:    -Save the application as a different name 
Recent Files:   -Open the most recently used files 
Summary > Add Indicator: -Add an indicator to the Wedge list.  Note that   

File menu shows Summary when SUMMARY 
is highlighted in the main window.  Otherwise it 
shows the Indicator (see examples below) 

Summary > Indicator: -Delete or Rename the selected indicator.  The 
Indicator option is only shown when the 
INDICATOR is highlighted in the main window. 
(See examples below) 

Exit:     -Exit out of Wedge 
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Toolbar: Database Explorer 

The DataBase Explorer menu allows you to receive or send databases. This 
menu is discussed later in the Wedge Reference Guide. 
 

 
 
 

Toolbar: Tools 

The Tools…Options menu gives a list of options. 
 
 

 
 
 

• The EventLog options are only used for software troubleshooting. 

• The Enable/disable XP Themes allows you to enable or disable any 
windows XP themes on the Wedge software. 
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Toolbar: Help 

Wedge Help has a few options: 

• To send feedback 

• View User’s guide 

• Check the software details. 
 
 

Help..Send Feedback 
To send feedback to GSE Scale Systems regarding the Wedge program, click on 
Help…Send Feedback 
 
 

 
 
 
Or the Send Feedback button 
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Help..Wedge User Guide 
To see the Reference Guides, Click on Help…Wedge user guide  
Or Click on the “?” button 
 

 
 
 
 

Help..About 
The About Box details the software name, version number, indicator firmware 
revision and the copyright. 
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Summary Window 

To use database features of Wedge, the indicators must first be set up to upload 
and download databases.  The indicators can be set up from the main Summary 
window.  The Summary window is the first window that is opened when Wedge 
starts up. 
 
By default, one (1) indicator is opened. The indicator is shown on the left side of 
the window. More indicators can be added. 
 
The main summary window allows you to enter in general information about the 
indicator(s) you are connected to. 
 
 
To name the application, type in the Name entry (A).   
 
For application comments, type in the  (B) Comments entry window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To Rename an indicator,  
Highlight the indicator name on the left, and right-click the mouse. Click on 
Rename. Type in the new name for the indicator. 
 
 
To Delete an indicator,  
Highlight the indicator name on the left, and right-click the mouse. Click on 
Delete Indicator.  The application must have a minimum of one indicator. 
 
 

(A) Name the 
application here 

(B) Type 
Comments here 
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To add an indicator,  
Highlight “Summary” on the left, and right-click the mouse. Click on Add 
Indicator. 
 

 

 

Set up a Serial Indicator 

RS232 
If the computer and indicator are hooked up through an RS232 port, make sure 
to set up the PC Port Settings to match the indicator’s port settings. The default 
settings are set up to match the default indicator settings.  To change any of the 
settings click on the drop down box, and select the appropriate option. 
 
 

 
 
 
If the USB port is connected to the serial port, and an OVERRUN error occurs, 
change the Line Delay to 50ms or 100ms. This will slow down the information 
passing from Wedge to the indicator.  
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RS485 
The RS-485 option allows multi-drop communications using RF wireless module 
hooked up to multiple indicators with different addressing. By having single 
adapter connected to the PC's comm. port, this software can talk to multiple 
indicators with RS-485 enabled. 
 
To use a RS485 network with Wedge, Click on the Enabled button, and select 
an address from the drop-down box. 
 

 
 

 

Set up an Ethernet connection 

If the computer and indicator are hooked up using an ethernet connection then 
click on Ethernet under Configure Settings. 
 

 
 
 

Select Enabled 

Select RS485 address 

List of all indicators 
connected to Ethernet 

Select 
Ethernet 
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Once Ethernet is selected, the Ethernet settings window will be opened.  A list of 
all available Ethernet connections to indicators is in the main window   
 
If all indicators are not listed, check to make sure they are all connected and click 
on Search Again. 
 
Once the correct Ethernet setting is found, type in the IP address in the top left 
box. 
 

 
 
 
To view the Ethernet setup information about a particular indicator, click on the 
View Ethernet Setup button.  The GSE Web Server website will open in a new 
window.  The Ethernet can be verified or changed on this website. 
  

 

 

Type in the 
appropriate IP 
address and port 
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Retrieving a serial number from an indicator 

To retrieve the serial number of an indicator, click on the Serial Number button. 
 

 
 

 
 
Wedge will get the serial number from the indicator and populate the entry 
window. 

 

Receiving Databases 

To receive a database, click on the Receive Database button  
 

 

  
 
Or go to DataBase Explorer..Receive Database(s) 
 

 
 

 

A new menu will open up. The first time a database is received from an indicator, 
ALL databases must be downloaded (received).  Once the database(s) are 
downloaded into Wedge, databases can be selected to upload or download. 
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Verify the selections, and click on Continue >> 

 

 
 

 

The data will download into the receive data window.  Once all the data is 
received, this window will close and the information will be downloaded into 
Wedge. 
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Viewing Database 

To view the database(s) click on database.  If no databases have been received 
yet, Wedge will prompt you to “Press the Receive Database Button”. 
 

 
 
  
If database(s) have been received, they will be listed under Instances.  In this 
example, there are 6 databases: #2 - #7.   
 
A database can be LOCKED so that the user can view the data, but not change 
it.  The locked database is specified by 3 asterisks (***).   
 
To LOCK the database, when you name the database at Parameter 700, add *** 
to the end of the name.  For example, to lock database 1 that’s named “Truck 
ID”, change the name to Truck ID***. 
 
 

 

Click on database to view 
the database(s) 
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Manipulating Database 

Once a database is downloaded into Wedge, the database can be managed. 
Unless the database is locked, you can: 
 
Add Row:  -Add a row to the bottom of the database 
Delete Row:  -Delete the selected row(s) 
Insert Row:  -Insert a row above the selected row 
Move up:  -Move the selected row up one 
Move Down:  -Move the selected row down one.  

 
 
Note: When editing the data,  
 

• Do not use double quotes  (“) in string values.   

• Do not change the format of any date fields 
 
If you do, the data will not transfer to the indicator correctly. 

 
 

Export Data 
Any one of the databases can be exported as a comma delimited file.  Once 
saved, a spreadsheet program, such as Excel or Access, can then open this file. 
 
To export the database, Click on Export Data.  Wedge will prompt to save the 
file. 
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Once the file is saved, you can open it in Excel (or Access).  The data can be 
changed, and then sent back to Wedge. 
 

 
Import Data 
To Import data from a comma delimited file, such as Excel, click on the Import 
Data button in Wedge.  
 

 
 
 
Select the correct file from the directory.  The data will automatically import into 
Wedge.  Once the data is imported, an information box will tell you that the 
database values were loaded successfully. 
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Sending a database 

To send a database to the indicator, click on the Send Database Seed Values 
button 
 

  
 
 
Or go to DataBase Explorer..Send Database(s). 
 

 
 
 

Success or Error message 
will display here. 
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From the Send Data box, there are few options to send the database(s) to the 
indicator: 
 

• Send all databases 

• Send the current database 

• Specify the database(s) to send. 
 

 
 
Remember, that if a database is locked, the values will NOT be updated in the 
indicator. 
 

 
 
If any errors occur, an information box will show an appropriate error message. 
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Database Errors 

Below is a list of possible database errors 
 

• Bad entry (invalid entry type) 

• Invalid database specified (database not defined) 

• Invalid column specified (column not defined) 

• Record not found 

• Not enough memory 

• Checksum error (row contains corrupt data) 

• List corrupt (bad link - list of stored rows not intact) 

• Operation aborted (i.e. search, print, sort, upload) 

• ID too long (entry exceeds maximum string length) 

• Data type mismatch 

• Greater than maximum number of row allowed 

• Invalid data type (string stored in numeric parameter; results in ‘0’ stored 
for numeric parameter) 

• Extra characters found (string characters found when numeric-only data 
was expected) 

• Not enough columns / row received during database upload 

• Too many columns / row received during database upload 

• Greater than maximum number of columns found (likely due to missing 
<CR> at end of each data row) 

• Value in column could not be recalled into the column’s parameter 
(example: invalid parameter instance such as P90.1 where macro #1 is 
not menu enabled and therefore cannot be assigned a name). 

 

Data Collection 

To collect data, real time, from an indicator (usually through a custom transmit), 
use the Data Collection tool.   It writes the data over an RS232 or Ethernet link to 
a .csv file.  The data can be formatted to a comma-delimited format.  The data 
can be saved to a file, or just tracked within Wedge’s Log Window. 
 
 

Setting up data collection for an indicator 
To set up how the data will be collected, go to the indicator screen.  The setup 
parameters are at the bottom half of the window. 
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Change the parameters for the Data Format, the Data Logger and the Data 
Template as required 
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Data Format 
To format how the data coming from the indicator is to be formatted (from text to 
a table format), use the Data Format parameters.  The Data Format parameters 
ask for the delimiter and the Termination Character. 
The choices for the Delimiter are: 

• Comma 

• Tab 

• Semi Colon 

• Space 

• Other 
 
If Other is specified, specify the character in the box to the right. 
 
 

 
 

 

 

When Wedge receives the specified Termination Character from the indicator, 
then it will start a new line. 
 
A common example would be to have the Termination Character set to a 
Carriage Return.  Then every time the custom transmits sends a carriage returns, 
the data coming into wedge will start a new line. 
 
The data will be collected in the Log Window at the bottom of the window. 
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Enable Data Logger 
To save the incoming data to a file, enable the DataLogger, and provide a file 
name. 
 

 

 

  
 

 

 

Data Template 
The Data Template allows you to format the incoming data into a table-format, 
including column headings.  
 

 
 

 

To add column headings, click on the Add Column button. 
 
To change or edit a column heading, highlight the column you want to change 
and click on Edit Column. 

 
To insert a column, highlight the column that’s just below where you want to 
insert the column, then click Insert Column. 
 
For example, to insert a column between ID and name, highlight name and click 
on Insert Column. 
 

 
 

 

 

Click on Insert 
Column 

Add the new 
column name 
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To delete a column, highlight the column you want to delete, and click on Delete 
Column. 

 
 

Start Data Collection 
To start collecting data go to Data Collection in the toolbar, or click on the Data 
Collection button. 
 

 
 

 

 
 

 

 

The Data Collection window will open.  Select the indicator from the Indicator 
List, then click on the Next>> button. 
 

 

The inserted column in inserted 
before the originally highlighted 
column 

Select the desired indicator, and 
then click Next>> 



Wedge Reference Guide 
 

Wedge Plus.doc 24 05/05/06 24

 

The Data Collection window will then show if the connection was successful.  
Click on the Next>> button. 
 
 

 
 

The data will start being shown in the DataLog at the bottom of the window. 
 

 

Stop Data Collection 
To stop the data collection, click on the Data Collection button or the Data 
Collection Menu…Stop. 
 

 

 
 

 

 
 

 

Wedge ActiveX Client 

The Power of ActiveX lets you view, and write data at the same time, which is 
coming from an indicator into an Excel spreadsheet, or Access Database.   
ActiveX Client uses Visual Basic (VBA) commands supported by Microsoft office 
at the same time. 
 
To use the Active X control, start Excel or MS Access.   
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Control Toolbox 
If the control toolbox is not visible, turn it on by using the View menu. Go to the 
Toolbars submenu and select the Control Toolbox (it should have a check 
beside it if it is selected). 
 

 
 

 
A toolbar with several control buttons should appear.  These are the standard 
controls and tool buttons from Visual Basic in Excel. 
 

 
 

 

 
Use the design mode button 
 

 

 
 
To switch to design mode (it should change appearance when you click on it and 
the tool tip should read "Exit Design mode" now because it will exit design mode 
if you click on it again!) 
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Once you are in design mode, click on the More Controls button (hammer and 
wrench). 
 

 

 
 
 
 

ActiveX Controls 
 

A list of all of the ActiveX controls registered to the PC will appear. You should be 
able to scroll through the list and find ‘Wedge.ActivexDataCollect’ control  
 

To add a control, double click on the Wedge.ActiveXDataCollect. A copy of the 
control should then appear in the spreadsheet. (The box handles indicate that 
you are still in design mode and the control has focus) 

 
 

Box handles 
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When the control has focus, you should be able to click on the Properties button 
(the finger pointing to the page) and the properties for the selected control should 
appear.  

 
 

 

 
 

 
 
 

Click these 3 dots to view the 
Property Page of ActiveX 
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The Wedge ActiveX Property page contains Configuration Screen that has 2 
properties. 

• During startup connect to Wedge Server: As the name implies this 
property will let the Wedge ActiveX Client try to connect to the Wedge 
Server during Startup if is running. 

• Wedge Server IP Address: The Wedge ActiveX client can run in the 
same machine where the Server is running or in a different machine. For it 
to run in a different machine the user has to specify the IP Address of the 
PC on which Wedge Server is running before  clickin the Connect Button. 

 

 
 

 

 

View Code 
The View Code  (magnifying glass over a page) is used to write commands back 
(by using command button "click" events) to the indicator through the 
Wedge.ActivexDataCollect.  
 
Click on the View Code button. 

 
 
 
The display window will switch to a VBA code view.  The cursor will appear in the 
command button code area.  
 
It will read something like: 
"Private Sub ActiveXDataCollect1_FireRealDataValues(ByVal strScaleName As 
String, ByVal arrValues As Variant)”. 
 
The cursor will be inside this code area.  
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You can now write code to execute the required command. This is standard VB 
syntax for code written for any ActiveX control. 
 

To return to the Excel spreadsheet, click on the Excel button on the toolbar 
under the menu bar. 
 

 
 

 

 
Once you have added all the controls and code that you wish to use, exit the 
design mode by clicking on the Design Mode button again. Click the Connect 
button that takes the ActiveX control to "live" mode and you should receive data. 
 
 

Sample VBA Code for Excel & Access: 
Below are examples of Visual Basic code.  One is for Excel, and the next one is 
for Access. 



Wedge Reference Guide 
 

Wedge Plus.doc 30 05/05/06 30

Sample VBA Code for Excel: 

 
Dim nSheetRow1 
Dim CellRange 
Dim RowCount, ColumnCount 
Private Sub ActiveXDataCollect1_FireColumnNames(ByVal strScaleName As 
String, ByVal arrColumns As Variant) 
Dim FirstCol As Integer 
 
Dim nColRow As Integer 
Dim strColName As String 
FirstCol = 1 
nColRow = 1 
Dim element As Variant 
For Each element In arrColumns 
    strColName = element 
    Sheet1.Cells(nColRow, FirstCol) = strColName 
    FirstCol = FirstCol + 1 
Next element 
End Sub 
 
Private Sub ActiveXDataCollect1_FireRealDataValues(ByVal strScaleName As 
String, ByVal arrValues As Variant) 
Dim StartCol As Integer 
Dim strColVal As String 
StartCol = 1 
Set CellRange = Sheet1.UsedRange 
RowCount = CellRange.Rows.Count 
ColumnCount = CellRange.Columns.Count 
 
If nSheetRow1 = 0 Then 
nSheetRow1 = 2 
End If 
If nSheetRow1 = RowCount Then 
Debug.Print "Reached Maximum" 
GoSub 1 
End If 
Dim element As Variant 
For Each element In arrValues 
 strColVal = element 
    Sheet1.Cells(nSheetRow1, StartCol) = strColVal 
    StartCol = StartCol + 1 
Next element 
nSheetRow1 = nSheetRow1 + 1 
Worksheets("Sheet1").Activate 
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ActiveWindow.SmallScroll down:=1 
1: 'Don't do anything 
End Sub 
 

Private Sub ActiveXDataCollect1_FireServerStatus(ByVal bRunning As Boolean) 
If (bRunning = False) Then 
Debug.Print "Server is Down" 
End If 
End Sub 
 

Sample VBA Code for Access: 

Option Compare Database 
Private Sub GeneralInfo1_FireRealDataValues(ByVal strScaleName As String, 
ByVal arrValues As Variant) 
Dim db As DAO.Database 
Dim rs As DAO.Recordset 
 
Set db = CurrentDb 
Set rs = db.OpenRecordset("General") 
If (rs.RecordCount > 0) Then 
rs.MoveLast 
End If 
 
rs.AddNew 
rs("ScaleName") = strScaleName 
Dim element As Variant 
Dim strTemp As String 
For Each element In arrValues 
If strTemp = "" Then 
strTemp = element 
Else 
strTemp = strTemp + "," + element 
End If 
Next element 
rs("ScaleValues") = strTemp 
rs.Update 
rs.Close 
db.Close 
End Sub 
 
Private Sub GeneralInfo1_FireServerStatus(ByVal bRunning As Boolean) 
If (bRunning = False) Then 
MsgBox "Server is Down" 
End If 
End Sub 
 




